
Diving Deeper into
Modeling Techniques

In This Chapter
You have worked on an outdoor scene throughout this book so far, and
now it’s time to bring the focus to some interior exercises that will give
you a little practice with techniques you have already learned and to
introduce you to some powerful new modeling methods.

You might not have realized it, but the old boat from the mid-1800s that
you created in Chapter 4, “Shipbuilding 101: The Making of a Boat,” is
operated from a high-tech command center located in the bow. This
advanced center is made of reinforced honeycomb walls to resist the
stress of battle and to protect from collisions with the ice of the artic.

Your task is to build these walls and some of the command and support
systems that are the heart of the boat. In the process of constructing this
scene, you learn new modeling techniques that offer options that give
you more control than others you have already learned. Again, there is
no right way or wrong way to model in 3ds max 6. What you need to do
is learn many of the possibilities and choose the method that works best
for you in any given situation.

Sometimes, one modeling method works best to a certain point, but then
you need to modify it in a way that the original technique does not allow.
The interior walls of the boat will be such an example, where box model-
ing works fine for the basic object, but you will then learn about a method
that enables you to deform that wall system into many more forms. You
will accomplish this with a World-space PathDeform modifier. 

CHAPTER 9
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You then need some equipment in the command center that allows for changes later
in the design process. Lofting is the answer to that challenge and enables you to
closely control the density (that is, number of faces) in the mesh you build. You use
lofting to create a control console and some air-handling ductwork.

Finally, you learn ways to create smooth surfaces while still retaining an efficient
mesh. Anyone can build rounded edges and smooth surfaces that enhance the light-
ing and materials in the scene, but only a master modeler can do it with efficiency
and productivity in mind.

Some of the techniques covered in this chapter include the following:

■ Box modeling—You learn to use box modeling techniques to create a com-
plex honeycomb wall system.

■ PathDeform—PathDeform is a powerful tool that enables you to deform 3D
mesh objects along a complex path.

■ Lofting—You learn to use one of the most powerful and flexible modeling
methods that converts simple 2D shape to complex 3D objects.

■ Smoothing—You learn the methods of smoothing surfaces to control the
“roundness” at shared edges of polygons.

Key Terms
■ World-space modifier—World-space modifiers are based on the fixed World

coordinate system. As modified objects are transformed through World space,
they “pass through” the modifications.

■ Object-space modifier—Modifiers that function in Object space use the
object’s own coordinate system to define the changes. As the object transforms
through space, the modifications travel with it.

■ Lofting—Lofting is the method of extruding one or more 2D shapes along a
single 2D path.

■ Path—The extrusion path in lofting.

■ Shape—A 2D shape that defines a cross-section in lofting.

■ Path and shape steps—These are intermediate steps between vertices of
shapes that define curvature.

■ Smoothing—This describes whether a shared edge between two faces appears
sharp or smoothed.
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Command Center Honeycomb Walls
Your ironclad boat is sailing in dangerous waters and needs a secure, high-tech com-
mand center from which to control and protect it from harsh environments.

Your task is to construct strong walls that conform to the shape of the bow of the
boat, always keeping in mind that the scope of the project might change at any
minute and that keeping the face count to a minimum is of paramount importance.

In this section, you review the technique of box modeling to build the initial hon-
eycomb walls. Your project director specifies that you will be viewing objects at a
close enough distance in the scene to require the detail that you can only get with
modeling.

You then deform the honeycomb walls to fit a rough V-shape of the bow of the boat
and add curvature from the floor to the ceiling. You accomplish this task with the
World-space PathDeform modifier.

Constructing the Honeycomb Wall
In Exercise 9.1, you use box modeling to edit a Box primitive that is converted to an
editable poly. Editable poly objects, you will remember, have some unique editing
functions (such as Connect and Inset) that are not available in other forms of 3ds
max 6 modeling. Each honeycomb panel will be about 2 feet by 2 feet square and 5
inches deep with a slight bevel at the edges. The beveled edges add more faces to the
object, but the way those bevels will interact with lighting is well worth the extra
geometry.

Remember, too, that although this exercise creates walls, you can apply the methods
you learn here to other objects, such as paneled doors, concrete floor systems, waf-
fled surfaces, or perhaps even a golf ball.

Exercise 9.1 Creating Honeycomb Objects

1. Open the file called Ch09_interior01.max on the CD-ROM. From the File pull-
down menu, choose Save As, point to an appropriate subdirectory on your hard
drive, and use the plus sign button to save a new file with the name incremented
to Ch09_interior02.max. This is a simple scene with a floor, ceiling, storage box,
and several 2D shapes that you use to construct 3D geometry. A camera is in the
scene, too.
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2. Right-click in the Top viewport to activate it and
select the triangular 2D shape called wall_path.
This shape defines the honeycomb wall around
the control room and to build the wall the right
size you need to know the length of the path. In
the Utilities panel, click the Measure button. In
the Shapes area of the Measure rollout, you see
that the Length of this object is 159 feet 10 3/8
inches (see Figure 9.1). For your purposes in this
exercise, rounding to 160 feet is fine. This becomes
the length of the wall.

3. In the Create panel, Geometry panel, click Box in
the Standard Primitives, Object Type rollout and
drag a box of any size in the Top viewport. In the
Modify panel, enter 10 in the Length field, 160 in
Width, and 1 in the Height field. In Length Segs,
enter 5, and in Width Segs, enter 80. This creates 2
foot by 2 foot polygons. Name the object Wall01.

4. Right-click the Camera01 viewport label and
choose Edge Faces from the menu. From the Tools
pull-down menu, choose Isolate Selection. Right-
click in the Camera01 viewport and press P to
switch to a Perspective viewport. Then, press U on
the keyboard to switch to a User viewport, which
is nonorthographic but has no perspective. Use
the Arc Rotate tool in the User viewport to view
the wall from the upper left and click the Zoom
Extents All button at the lower right of the dis-
play to see the entire box in all viewports. It
should look similar to Figure 9.2.

5. Right-click the Wall01 and choose Convert To,
Convert to Editable Poly in the Quad menu. In
the Modify panel, Stack view, highlight Polygon
sub-object mode. On the main toolbar, make sure
you are in Window selection mode. In the Left
viewport, drag a selection window around the top
of the Wall01 to select only the top polygons. In
the Edit Polygons rollout, click the Settings but-
ton for Inset. This insets 1 inch around the
perimeter of the selection set. In the Inset 

FIGURE 9.1
Use the Measure tool in the
Utilities panel to measure the
length of the wall_path shape.
Round up to the nearest foot
and make note of the number;
in this case, 160 feet.

On slower machines, clicking
OK could result in a few sec-
onds pause while the settings
are calculated and applied.
Have patience.
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FIGURE 9.2 Switch the Camera01 viewport to a Perspective viewport by pressing P, then
to a User viewport by pressing U, and Zoom and Arc Rotate to see the Wall01
object that is in Isolation mode.

FIGURE 9.3 Using Inset in By Polygon mode insets each polygon individually.

Polygons dialog, select the By Polygon radio button to inset each polygon individ-
ually. Enter 3" in the Inset Amount field and press Enter. This creates a space
between each selected polygon (see Figure 9.3). Click OK. Zoom the User viewport
to see the results.
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6. In the Edit Polygons rollout, click the Settings button for Bevel. Enter –1 in both
the Height and the Outline Amount fields. The bevel type is not important now
because all the polygons are separated by unselected polygons through which
the effect cannot pass. Click OK. This puts a 45-degree chamfer at all edges of
the panels.

7. In the Edit Polygons rollout, click the Settings button for Extrude. Enter –4 in the
Extrusion Height field, and press Enter for a deeper-set panel. Click OK. (See
Figure 9.4). On the main toolbar, Named Selection Sets window, enter panels and
press Enter. This makes it easier to reselect the panels if you need them later.

FIGURE 9.4 Extrude the selection by minus 4 inches and create a named selection set of
the polygons for later use.

8. In the Modify panel, Stack view, highlight Editable Poly at the top of the list to
exit sub-object mode. In the viewports, click the Exit Isolation Mode button to
return all objects to the scene.

9. Close all windows and dialogs and save the file. It should already be called
Ch09_interior02.max.

Bend It, Shape It…Deforming the Wall
You now have a particularly long wall lying flat on the floor, but you want it to be a
futuristic curved wall that fits the shape of the boat’s bow.

In Exercise 9.2, you learn to use the World-Space PathDeform modifier to use the tri-
angular shape with the rounded corners as the base of the wall. You also bend the wall
so that it turns inward as it reaches the ceiling.

The important thing about PathDeform is that the object being deformed has enough
segments along the path to accept the deformation.
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Exercise 9.2 Deforming a Bent Object Along a Path

1. Open the file called Ch09-interior02.max on the
CD-ROM or from the preceding exercise. From the
File pull-down menu, choose Save As, point to an
appropriate subdirectory on your hard drive, and
use the plus sign button to save a new file with
the name incremented to Ch09_interior03.max.

2. First, move the pivot point of Wall01 to align it
with what will become the bottom of your wall.
Remember that the Bend modifier uses the pivot
of an object as the default center of bending. With
Wall01 selected, in the Hierarchy panel, Adjust
Pivot rollout, click the Affect Pivot Only button.
On the main toolbar, click the Align button. In
the Top viewport, pick Wall01. In the Align
Selection dialog, check Y Position, Pivot Point in the Current Object column, and
Maximum in the Target Object column (see Figure 9.5). Click OK. In Hierarchy
panel, click Affect Pivot Only to exit that mode.

The correct axes to use have
been predetermined through
some trial and error to make
this exercise flow more
smoothly. The actual settings
depend on which viewports
the objects were created in
and what reference coordinate
systems are in effect; so, the
settings might differ if you re-
create this exercise on your
own.

FIGURE 9.5 In the Align Selection dialog, check Y Position and choose Pivot Point in
Current Object column and Maximum in Target Object column. Click OK.

3. In the Modify panel, Modifier List, choose the Bend modifier. In the Parameters
rollout, enter 25 in the Angle field, 90 in the Direction field, and check the Y radio
button in the Bend Axis area. Your wall goes through distortions with each new
data entry, but in the end, it looks like Figure 9.6.
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FIGURE 9.6 In Affect Pivot Only mode, use Align to align the pivot point to the maximum
side of the Y-axis of the Top viewport. 

4. Now, deform the bent wall around the path. With Wall01 selected, go to Modify
panel, Modifier List, and choose the PathDeform (WSM) modifier in the World-
Space modifiers list (see Figure 9.7).

FIGURE 9.7 Select Wall01 and apply the PathDeform (WSM) World-space modifier.
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5. In the Parameters rollout, click the Pick Path but-
ton and, in the Top viewport, pick wall_path.
Wall01 deforms very oddly. In the Parameters roll-
out, click the Move to Path button. Enter 90 in
the Rotation field and check the X PathDeform
Axis radio button. This orients the wall correctly
on the path (see Figure 9.8).

Do not choose the Patch-
Deform (WSM) object or the
PathDeform further down in
the Modifier List under
Object-space modifiers.

FIGURE 9.8 In PathDeform (WSM) Parameters rollout, click Pick Path and pick wall_path,
click Move to Path, enter 90 in Rotation, and check the X PathDeform Axis
radio button.

6. Right-click in the User viewport and press C to switch to the Camera01 viewport.
Right-click the Camera01 viewport label and clear the Edged Faces option. The
viewport should look like Figure 9.9. The bevel on the panel edges catch the light
to enhance the look.

7. Close all windows and dialogs and save the file. It should already be called
Ch09_interior03.max.
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FIGURE 9.9 Switch the User viewport to the Camera01 viewport by pressing C and turn off
Edged Faces by right-clicking the viewport label and clearing it in the menu.

A Modeling Technique Called Lofting
The term lofting comes from shipbuilding. The ribs of a ship are drawn out full size
on the floor of a loft at the boatyard. The ribs are then cut and positioned along the
keel of the ship, and the skin is applied to create the hull.

In 3ds max 6, you determine a 2D path (keel) and 2D cross-section shapes. 3ds max
6 then applies the skin for you, making a 3D surface.

The biggest advantage of lofting is that simple 2D shapes can generate complex 3D
objects with flexible editing and control of face density.

There can only be one path along which any number of shapes can be placed. The
path and shape objects can be open or closed shapes. The only real restrictions are
that each shape along the path must have the same number of splines and a path
can have only one spline. For example, you cannot loft a Circle primitive and a
Donut primitive on the same loft path, nor can you loft a shape along a Donut prim-
itive. The Circle primitive has one spline, and the Donut primitive has two.

In this section, you create two objects with lofting: a command console and an air-
handling duct. The console will be a single shape along the path, and the duct will
be two shapes on the path. This creates a transition from a circular to rectangular
cross-section.
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One particularly important aspect of lofting is the relative position of the first vertex
of each shape along the path. The loft mesh surface is created by first stitching
vertices and shape steps to form the segments of the skin. You learn more about these
terms as you go along in the exercises.

Another important thing to know is that the pivot point of a shape determines where
it attaches to the start (first vertex) of the path. Transforming the pivot point of the
shape affects the orientation on the path.

Finally, the Local reference coordinate system axes of the shape and path affect the
orientation of a shape on the path. The positive local Z-axis of the shape aligns along
the path.

A lack of understanding of the first vertex and the default orientation keeps many
users from taking advantage of the power of lofting. The important fundamentals in
this chapter enables you to take full advantage of the tool.

You also learn the power of mesh optimization that lofting has to make your models
more efficient or more detailed as you might require.

Lofting Fundamentals
In Exercise 9.3, you learn to loft a single shape along a path to build a command con-
sole for the control instruments for your boat. The console could be created with
other techniques, such as box modeling, but you would not have the ease of editing
or the ability to optimize the mesh.

Exercise 9.3 Lofting 2D Shapes Along a 2D Path

1. Open the file called Ch09_interior03.max on the CD-ROM or from the preceding
exercise. From the File pull-down menu, choose Save As, point to an appropriate
subdirectory on your hard drive, and use the plus sign button to save a new file
with the name incremented to Ch09_interior04.max.

2. In the Camera01 viewport, using Select by Name, select console_shape, a closed
parallelogram, and console_path, an open inverted U shape. In the Tools pull-down
menu, choose Isolate Selection (Alt+Q) to hide the other objects. Click the Zoom
Extents All button. In the Camera01 viewport, press P to switch to a Perspective
view and Arc Rotate so that the viewport looks similar to Figure 9.10.
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FIGURE 9.10 Select console_shape and console_path and isolate the selection. Zoom
Extents All and switch the Camera01 viewport to the Perspective viewport
and Arc Rotate to be viewing from upper left.

3. In the Perspective viewport, select console_path. In
the Create panel, Geometry panel, click Standard
Primitives, and choose Compound Objects from
the list. In the Object Type rollout, click the Loft
button (see Figure 9.11).

4. In the Creation Method rollout, click the Get
Shape button and, in the Perspective viewport,
pick console_shape. Your first lofted object looks
like Figure 9.12. A nice object, but not the right
console for your boat. The object would not sit
on the floor, but would drop below it.

5. Remember that the shape’s pivot point attaches
itself to the path’s first vertex, and the shape’s
pivot point location is in the geometric center of
the shape. You move the pivot point to the lower-
left corner of the console_shape, which modifies
the loft object. On the main toolbar, click the
Select Object button. In the Top viewport, select
console_shape. You see the pivot tripod axis in the
center of the modified rectangle shape. In the
Hierarchy panel, click the Affect Pivot Only

FIGURE 9.11
In the Create panel, Geometry
panel, Compound Objects
panel, check the Loft button in
the Object Type rollout.
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FIGURE 9.12 In the Creation Method rollout, click Get Shape, and pick
the console_shape object in the Perspective viewport. The
shape is lofted along the path. However, the console is
backward and too low in relation to the floor surface.

Generally, you select the path
and then use Get Shape to
attach a clone (instance) of
the shape to the path.

If the shape is already posi-
tioned correctly in the scene,
however, you may use the Get
Path option to clone the path
to the shape’s location.

FIGURE 9.13 In the Hierarchy panel, Affect Pivot Only mode, use Align to position the pivot
point at the minimum axes of both X and Y position.

button. On the main toolbar, click the Align button and then click the edge of
console_shape in the Top viewport. In the Align Selection dialog, check X and Y
Position, check Pivot Point in the Current Object column and Minimum in the
Target Object column. The pivot point aligns to the lower-left corner of the shape
as seen in the Top viewport (see Figure 9.13). Click OK. In the Hierarchy panel,
click Affect Pivot Only to exit that mode.
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6. In the Perspective viewport, select the Loft01
object. In the Modify panel, rename it Console01.
In the Creation Method panel, click the Get
Shape button and pick the console_shape in
the viewport. The Console01 jumps up and the
path is now defining the inside-bottom corner.
The console still slopes in the wrong direction,
however.

7. While you are still in Get Shape mode, hold the
Ctrl key and pick the console_shape in the
Perspective viewport again. Holding the Ctrl key
while performing a Get Shape action flips the
shape clone 180 degrees around its pivot point.
The negative local Z-axis of the shape orients
down the path (see Figure 9.14).

It is important that you are in
the Modify panel when you
pick Get Shape and pick the
console_shape. Otherwise, you
would be creating a completely
new loft object.

The shape is cloned to the path
as an instance to create the
object. Any modifications to the
original shape are passed to the
clone to edit the loft object.
However, moving the pivot
point is not a modification, but
a transformation, and you must
use Get Shape to update the
changes on the loft object.

FIGURE 9.14 Holding the Ctrl key while performing a Get Shape oper-
ation in the Modify panel flips the shape 180 degrees and
replaces the current shape on the first vertex of the path.

8. Close all windows and dialogs and save the file. It should already be called
Ch09_interior04.max.

Modifying the Shapes to Change the Loft
In Exercise 9.4, you learn to modify the original 2D loft shape to make relatively com-
plex changes to the 3D loft object. You are taking advantage of the fact that the
cloned shape on the path is an instance of the original, a powerful option.
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You add a kick space to the front of the console and round the sharp edge along the
top back of the sloped surface.

Exercise 9.4 Modifying the Original Shape to Change the Instance
Clone on the Path

1. Open the file called Ch09-interior04.max on the CD-ROM or from the preceding
exercise. From the File pull-down menu, choose Save As, point to an appropriate
subdirectory on your hard drive, and use the plus sign button to save a new file
with the name incremented to Ch09_interior05.max.

2. On the main toolbar, click the Select Object button. In the Top viewport, select
console_shape. In the Modify panel, Stack view, expand Editable Spline and high-
light Segment sub-object level. Select the shorter vertical segment on the right
side of the shape. In the Modify panel, near the bottom of the Geometry rollout,
enter 2 in the Divide field and click the Divide button. This adds two new vertices
to the segment (see Figure 9.15).

FIGURE 9.15 In sub-object Segment mode, select the short vertical segment of console_shape.
Enter 2 in the Divide field of the Geometry rollout, and click Divide to add two
new vertices to the segment.

3. In the Modify panel, Stack view, highlight Vertex sub-object level. On the main tool-
bar, click the Select and Move button. In the Top viewport, move the three vertices
on the right side to look similar to Figure 9.16. You notice in the other viewports that
the changes are being reflected in the Console01 object (see Figure 9.17).
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FIGURE 9.16 Move three vertices down and/or left to define a kick space at the bottom right
of the 2D shape. Use the Transform gizmo, but just guess at the size for this
example.

FIGURE 9.17 A kick space is being created at the inside bottom of Console01 as you modify
the 2D shape.

4. While in Vertex sub-object mode, select the top
two vertices of console_shape. In the Modify
panel, Geometry rollout, enter 4 in the Fillet field
and press Enter. This rounds the top edges of the
console for the entire length (see Figure 9.18). In
Stack view, highlight Editable Spline to exit sub-
object mode.

Do not click the Fillet button
during this operation. There
are two ways to use Fillet: by
entering numbers in the field
and pressing Enter or by click-
ing the Fillet button, and then
interactively dragging the fillet
in the viewport.
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FIGURE 9.18 In Vertex sub-object mode, select the top two vertices of the shape and enter 4
in the Fillet field. Press Enter to see the results on the shape and the loft object.

5. Close all windows and dialogs and save the file. It should already be called
Ch09_interior05.max.

Loft Optimizations
You have created a loft object, but is it as efficient as it could be? The face count of
lofted objects with curves can get out of control quickly, so it is important to be
vigilant.

In Exercise 9.5, you check the face count of the object, and then use path and shape
step controls to adjust the density of the mesh so that it retains the look, but is sub-
stantially more efficient.

Exercise 9.5 Using Path and Shape Steps to Optimize Loft Objects

1. Open the file called Ch09_interior05.max on the CD-ROM or from the preceding
exercise. From the File pull-down menu, choose Save As, point to an appropriate
subdirectory on your hard drive, and use the plus sign button to save a new file
with the name incremented to Ch09_interior06.max.

2. In the Perspective viewport, select Console01. Right-click the Perspective label
and check Edged Faces in the menu. Right-click Console01, and choose Properties
in the Quad menu. You see that the object has 1,820 faces. Click OK. In the
Perspective viewport, you can see segmentation cause by vertices, path steps,
and shape steps (see Figure 9.19).
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FIGURE 9.19 There are, by default, five path steps and five shape steps between each ver-
tex to define curvature. The segmentation shows this when Edged Faces is on
or when in Wireframe mode.

3. In the Modify panel, Skin Parameters rollout,
decrement the Path Steps by 1 until you get to 0.
Watch the Console01 in Perspective as you change
each amount. When you get to 0, you will only
have horizontal segments, except where the path
vertices are. There is no curvature in the path, so
the object does not change. Right-click Console01
and choose Properties. You see that there are only
380 faces. Click OK to close the dialog.

4. Decrement the Shape Steps field by 1 until you get to 0. The Console01 now only
has 60 faces, but the curvature is completely gone from the object and it looks
terrible (see Figure 9.20).

5. The Path Steps and Shape Steps settings adjust the number of steps between each
vertex equally, so just adding shape steps increases the face count in places where
the extra detail is not needed. To repeat the definition of path and shape steps,
there are points between vertices that define curvature. The path has no curva-
ture, so 0 Path Steps is fine. The shape has curvature only at the filleted areas.
Instead of adjusting steps at this point, you would be better off adding vertices to
the curved segments of the original 2D shape. In the Top viewport, select con-
sole_shape. In the Modify panel, Stack view, highlight Segment and select the two
curved segments at the upper corners. In the Geometry rollout, enter 3 in the
Divide field and click the Divide button. This adds three new vertices to define
the curvature (see Figure 9.21). Exit sub-object mode.

There will always be segment
lines defined by any vertex in
the shapes or paths.
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FIGURE 9.20 With Path Steps and Shape Steps set to 0, the object is only 60 faces but is
no longer acceptable visually.

FIGURE 9.21 Using Divide to add three new vertices to each curved segment of the original
shape adds segments to the mesh only where needed.
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6. Select Console01, right-click it, and choose
Properties to see that the object looks like it did
originally (but instead of 1820 faces, it now has
only 108). Click the Exit Isolation Mode button to
return all objects.

7. Save the file. It should already be called
Ch09_interior06.max.

Lofting Multiple Shapes on a Single Path
In Exercise 9.6, you learn to loft two shapes on the
same path for a more complex object. The important
thing learned here is the effect of the first vertex on a lofted object. With a single
shape, the first vertex has no noticeable effect because it is constant along the path.
If the first vertices of multiple shapes are not in the same relative position, however,
twisting occurs along the loft object. You learn to correct that.

Exercise 9.6 Lofting with Multiple Shapes

1. Open the file called Ch09_interior06.max on the CD-ROM or from the preceding
exercise. From the File pull-down menu, choose Save As, point to an appropriate
subdirectory on your hard drive, and use the plus sign button to save a new file
with the name incremented to Ch09_interior07.max.

2. Using Select by Name, select duct_path, duct_shape01, and duct_shape02. Isolate
the selection. This is another inverted U that will be used as the path, and a
square and a circle, respectively, that will be shapes. Click Zoom Extents All to
view all objects. With the shapes all selected, right-click in the Top viewport and
choose Properties in the Quad menu. In the Object Properties dialog, Display
Properties area, check Vertex Ticks (see Figure 9.22). This enables you to see the
vertices of the selected shapes without being in sub-object mode.

3. You notice a white box around each first vertex on each spline of each shape.
(They are all simple shapes.) The first vertex of the square and circle are out of
relative position by 45 degrees. In the Top viewport, select duct_path. In the
Create panel, Geometry panel, Compound Objects panel, click the Loft button. In
the Creation Method rollout, click the Get Shape button. In the Top viewport,
pick duct_shape01 (square). You now have a simple square duct in the scene. The
Path Steps and Shape Steps settings are remembered from the preceding exercise.
In the Modify panel, Skin Parameters rollout, enter 5 in both the Path Steps and
Shape Steps fields. Rename the object Duct01. You will optimize later (see Figure
9.23). In the Skin Parameters rollout, clear the Transform Degrade check box so
the changes you make later will be visible in the viewport.

Knowing this simple lofting
process of adjusting path and
shape steps is critical to fast,
flexible modeling in 3ds max 6.
Make sure you understand this
exercise before proceeding.
Otherwise, it is much too easy
to overwhelm even the most
powerful computers with lofted
objects.



Chapter 9: Diving Deeper into Modeling Techniques 297

FIGURE 9.22 By turning Vertex Ticks on in the Object Properties dialog, you can see vertex
ticks in the viewports without being in sub-object mode.

FIGURE 9.23 A square shape lofted along a Path with both the Path Steps and Shape Steps
fields set to 5.
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4. In the Modify panel, Path Parameters rollout, enter 100 in the Path field and
press Enter (see Figure 9.24). This puts the active Get Shape level at 100 percent
along the path—that is, at the other end as indicated by the yellow tick at the
end of the path.

FIGURE 9.24 Setting Path to 100 moves the active Get Shape level from the start of the path
to the end of the path as indicated by the yellow tick. Otherwise, when you get
the next shape, it would just replace the one at 0 percent along the path.

5. In the Creation Method rollout, click the Get Shape button to turn it on and pick
duct_shape02 (circle) in the Top viewport. The Duct01 now starts as a square cross-
section on the left and ends as a round cross-section on the right with a 45 degree
twist along the way (see Figure 9.25).

FIGURE 9.25 With a square shape at the start and a round shape at the end, the Duct01
changes form, but has an unwanted twist along the length.
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6. Not only is there a twist, the duct should also not transition from square to circle
over the entire length. You first get the transition in a smaller area halfway along the
path. In the Modify panel, Path Parameters rollout, enter 45 in the Path field and
press Enter. The active Get Shape level is now just before the halfway point on the
path. Click the Get Shape button, if it is not still active, and pick the duct_shape01
(square) in the Top viewport. Now, the Loft starts as a square cross-section, holds that
form until 45 percent, and then changes from a square to a circle.

7. In the Path field, enter 60. With Get Shape on, pick the duct_shape02 again. Now,
the transition takes place within 15 percent of the Path (between 45 and 60), but
still has the twist.

8. Loft objects also have sub-object levels. In the Stack view, expand Loft and high-
light Shape in the list. On the main toolbar, click the Select Object button. In the
Front viewport, move the cursor over the loft object and pick when you are over
the shape clone at 60 percent and see the small crosshair cursor (see Figure 9.26).
The clone shape turns red when selected.

FIGURE 9.26 In Shape sub-object mode, select the clone shape at 60 percent along the
path. It turns red when selected.

9. On the main toolbar, click the Select and Rotate button. Notice that the reference
coordinate system is locked on Local for each shape. In the status bar at the bot-
tom of the display, toggle to Offset Transform Type-In mode. In the Transform
Type-In Z-axis field at the bottom center of the display, enter 45 and press Enter
(see Figure 9.27). The twist is removed at that point. 
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FIGURE 9.27 Toggle Offset Transform Type-In mode and enter 45 in the Z-axis rotation.
Press Enter. The twist is removed at that point.

10. Select the clone shape at 100 percent of the way
along the path and rotate it 45 degrees. The twist
is removed from the entire Loft object. In the
Stack view, highlight Loft level to exit sub-object
mode. In the Skin Parameters rollout, set the
Shape Steps to 3 and the Path Steps to 0 (see
Figure 9.28).

11. Exit Isolation mode. You now have an efficient console and duct, but there is
some strange shading (see Figure 9.29). You take care of that in Exercise 9.7.

12. Close all windows and dialogs and save the file. It should already be called
Ch09_interior07.max.

In Transform Type-In for rotation,
positive angles are counter-
clockwise because you are
looking down the axis.
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FIGURE 9.28 Rotating both circle clone shapes 45 degrees removes any twist, and setting
the Shape Steps field to 3 and the Path Steps field to 0 is a good compromise
between efficiency and visual acceptance.

FIGURE 9.29 The duct and the console are efficient, but have some strange shading on the
surfaces.

Smoothing Faceted Surfaces
Through the creation and editing of lofted objects, there has been a process going on
that assigns numbers called smoothing group numbers to each face. The rule is that
if two adjacent faces share a common number, the edge between them is smoothed;
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otherwise, it is a hard edge. 3ds max 6 does a pretty good job at guessing, but is not
always right, causing odd shading in some areas and noticeable facets in other areas.
In Exercise 9.7, you apply a Smooth modifier that reapplies the smoothing group
numbers based on the angle that faces meet. This makes your objects appear correct
in the scene.

Exercise 9.7 Assigning Smoothing Groups with Smooth Modify

1. Open the file called Ch09_interior07.max on the CD-ROM or from the preceding
exercise. From the File pull-down menu, choose Save As, point to an appropriate
subdirectory on your hard drive, and use the plus sign button to save a new file
with the name incremented to Ch09_interior08.max.

2. On the main toolbar, click the Select Object button and select the ceiling object.
Click the Select and Move button and move the ceiling object up so that the duct
shows in the room (see Figure 9.30). 

FIGURE 9.30 Move the Ceiling01 object up to reveal the entire duct.

3. Activate the Camera01 viewport and, on the main toolbar, click the Quick Render
button to render the scene. In the Rendering pull-down menu, choose RAM Player.
In the RAM Player dialog, click the Open Last Rendered Image in Channel A but-
ton (teapot on the left). Click OK in the RAM Player Configuration dialog to
accept the defaults. Close the Rendered Frame Window. Minimize (do not close)
the RAM Player window.
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4. Click the Select Object button and, in the Top viewport, select Console01. In the
Modify panel, Modifier List, choose Smooth modifier. In the Parameters rollout,
check the Auto Smooth check box. It is set for a threshold of 30 degrees. If two
faces share a common edge at 30 degrees or less, the edge will be smoothed.
Otherwise, it will be a hard edge. Render the Camera01 viewport and not much
will have changed with the Console01. In the Threshold field, enter 15.8 and
press Enter. Render the Camera101 viewport. There is now an acceptable level of
smoothing to make the object look better. 

5. Select the Duct01 and Wall01 objects and apply a single Smooth modifier to the two
objects with Auto Smooth checked on and a threshold of 22.8 degrees. Render the
Camera01 viewport. Maximize the RAM Player and click the Open Last Rendered
Image in Channel B. Click OK. In the RAM Player, click and hold in the display area
and move the cursor back and forth to compare the two images (see Figure 9.31).

FIGURE 9.31 Default loft smoothing is shown on the left in the RAM Player (Channel A), and
smoothing with the Smooth modifier is shown on the right.
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6. Close all windows and dialogs and save the file. It should already be called
Ch09_interior08.max.

Summary
In this chapter, you learned more about box modeling and about deforming 3D
objects along a shape with PathDeform (WSM) modifier. Then, you learned the
important steps that make lofting a productive, efficient tool in 3ds max 6. It enables
you to create very complex 3D objects with simple 2D shapes that are editable to
affect the mesh object.

Some of the techniques covered in this chapter included the following:

■ Box modeling—You learned to use box modeling techniques to create a com-
plex honeycomb wall system.

■ PathDeform—PathDeform is a powerful tool that enables you to deform 3D
mesh objects along a complex path. You learned to apply it to create a complex
wall.

■ Lofting—You learned to use one of the most powerful and flexible modeling
methods that converts simple 2D shapes to complex 3D objects.

■ Smoothing—You learned ways to smooth surfaces to control the “roundness”
at shared edges of polygons.


